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Digital Philately for Beginners

Welcome and Introduction



10.30 am Tea, coffee and biscuits

11 am Welcome and opening remarks Frank Walton 

11.10 am Scanning philatelic material Mark Bailey

Demonstration Mark Copley

Hands-on practical session All participants

12 noon Making enlarged, detailed images Mark Copley

12.30 pm Lunch break

Optional: Lunch at the King’s Head – pre-book the food

1.30 pm Different colour standards Mark Bailey

1.35 pm Preparation of physical display sheets Mark Copley

Hands-on practical session All participants

3 pm Refreshment break

3.15 pm Producing digital exhibits Mark Copley

3.45 pm Preparing slideshow presentations Mark Bailey

4.15 pm Wrap-up session, with Questions & Answers All participants

4.30 pm Closing remarks Mark Bailey
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Scanning Philatelic Material



Placing the items for scanning. 

Some programs prompt you to place the 
item for scanning, others do not. 

Place items face down on the printer or 
scanner surface. 

Align within the arrows or grids on the 
device. 

Close the lid if there is one.

Provide a contrasting background for the 
item, by placing a sheet of suitably 
coloured card or paper on top of the item 
being scanned, as most scanners have a 
white lining to the scanner lid which does 
not provide good contrast for stamps. 
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Scanning Philatelic Material



Navigate to the scanning program's location. 

In Windows, click on the Start button to bring up available programs 
and applications. 

If you have one, you can click on the scanner icon. 
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Scanning Philatelic Material



To run the scanning program, having 
found it, it can be activated and 
opened usually by double clicking on 
the program's name or by pressing the 
scan button on your printer or scanner.
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Scanning Philatelic Material
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Scanning Philatelic Material

For Windows computers, a basic built in utility is 
called Windows Fax and Scan and it can be 
found by using the Search bar in the Start menu.



Scan Settings
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Scan Settings
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Resolution
(Number of Dots Per Inch)

Scan Settings
Choose your 

scanning preferences 
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Resolution
(Number of Dots Per Inch)

Scan Settings Resolution determines the sharpness of the image and amount of detail. 

A higher resolution will make the details of the picture more noticeable, and to 
make a sharper image, you should increase the resolution. 

Note though that this will also increase the size of the image, and dramatically 
increase the size of the file. You may not be able to send it as an email 
attachment without making it smaller. 

Resolution is a measure of pixel density, usually measured in dots per inch (dpi). 

Images on websites often have a resolution of 72 dpi. This means that a 1-inch 
square contains a grid of pixels that is 72 pixels wide by 72 pixels high. 72 x 72 = 
5184 pixels per square inch.

High quality printed images in books and magazines have a higher resolution 
than computer screens. 

Printed images often use either 300 dpi or even 600 dpi. 

As a minimum for philatelic material use 300 dpi.  

Some scanners support higher resolutions such as 600 dpi or up to 2400 dpi.

Choose your 
scanning preferences 
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Although a digital image contains a specific amount of image data, it doesn’t have a specific physical output size or 
resolution. As you change the resolution of an image, its physical dimensions change, and as you change the width 
or height of an image, its resolution changes.

Two images (A and B) with the 
same image data and file size but 
different image size and resolution; 
C shows that a higher resolution 
means better quality. 



400%100%

Resolution: 600 DPI
912 x 857 pixels
= 781,584 pixels

400%

Resolution: 100 DPI
153 x 142 pixels
= 21,726 pixels

100%



Output Type
(Colour Mode or Format)

Resolution
(Number of Dots Per Inch)

Scan Settings

You will typically have the choice of scanning in colour, black and 
white, or greyscale. 

Choose your 
scanning preferences 
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Output Type
(Colour Mode or Format)

Resolution
(Number of Dots Per Inch)

Output File Type

Scan Settings

You can also choose the digital file format in which you want to 
save your picture (usually JPG or JPEG, TIFF or PNG, but also 
perhaps GIF and Exif).  

Choose your 
scanning preferences 
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As JPEG is "lossy", the image you get out of 
decompression isn't quite identical to what 
you originally put in. The algorithm achieves 
much of its compression by exploiting known 
limitations of the human eye, notably the fact 
that small colour details aren't perceived as 
well as small details of light-and-dark. 

A lot of people are put off by the term "lossy
compression“, but when it comes to 
representing real-world scenes, no digital 
image format can retain all the information 
that impinges on the human eye. By 
comparison with the real-world scene, JPEG 
loses far less information than another file 
format, GIF (Graphics Interchange Format).

A useful property of JPEG is that the degree of 
lossiness can be varied by adjusting 
compression parameters. This means that the 
image maker can trade off file size against 
output image quality. 

JPG files, also known as JPEG files, are a 
common file format for digital images. 
When JPG files are saved, they use a "lossy" 
compression (lossy meaning "with losses to 
quality"). This causes some image quality to 
be lost when the image data is compressed 
and saved, and this quality can never be 
recovered. File compression methods for 
most other file formats are lossless, and 
lossless means "fully recoverable". JPEG 
stands for Joint Photographic Experts Group, 
the committee that created the file type.  
JPEG is a standardised image compression 
mechanism. JPEG is designed for 
compressing either full colour (24 bit) or 
greyscale digital images of "natural" (real-
world) scenes. It works well on photographs, 
naturalistic artwork, and similar material; 
not so well on lettering, simple cartoons, or 
black and white line drawings (files become 
very large). 

For good-quality, full-colour source 
images, the default quality setting (Q 
75) is very often the best choice. Try Q 
75 first; if you see defects, then go up. 

Except for experimental purposes, 
never go above about Q 95; using Q 
100 will produce a file two or three 
times as large as Q 95, but of hardly 
any better quality. 

If you want a very small file (e.g. for 
preview or indexing purposes) and are 
prepared to tolerate large defects, a Q 
setting in the range of 5 to 10 is about 
right. A setting of Q 2 or so may be 
amusing as "op art". 
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TIFF (Tag Image File Format) is a common 
format for exchanging raster graphics (bitmap) 
images between application programs, 
including those used for scanner images. A 
TIFF file can be identified as a file with a ".tiff" 
or ".tif" file name suffix. The TIFF format was 
developed in 1986 by an industry committee 
chaired by the Aldus Corporation (now part of 
Adobe Software). Microsoft and Hewlett-
Packard were among the contributors to the 
format. TIFF files can be in any of several 
classes, including greyscale, colour palette, or 
RGB full colour.

Output File Type
The Graphics Interchange Format (GIF) was developed in 1987 at the request 
of Compuserve, who needed a platform independent image format that was 
suitable for transfer across slow computer connections. It is a compressed 
(lossless) format, using something known as LZW compression that was 
invented by Abraham Lempel, Jacob Ziv, and Terry Welch. It is an 8 bit format, 
which means the maximum number of colours supported by the format is 256. 
This makes it unsuitable for high quality images.

In 1995 Unisys, who created the GIF format, announced that they would be 
enforcing the patent on the LZW compression technique used for GIF. Thus 
commercial developers that include the GIF encoding or decoding algorithms 
have to pay a license fee to Compuserve. This does not concern users of GIFs or 
non-commercial developers. However, a number of people got together and 
created a completely patent-free graphics format called PNG (pronounced 
"ping"), the Portable Network Graphics format. PNG is superior to GIF in that it 
has better compression. PNG supports palette-based images (with millions of 
colours), greyscale images, and full-colour non-palette-based images. PNG was 
designed for transferring images on the Internet, not for professional-quality 
print graphics, and therefore does not support non-RGB colour standards such 
as CMYK.

Exchangeable image file format (Exif) is a standard that specifies the formats 
for images, sound, and ancillary tags used by digital cameras (including 
smartphones), scanners and other systems handling image and sound files 
recorded by digital cameras. The specification adds specific metadata tags to 
JPEG for compressed image files and TIFF for uncompressed image files.

Metadata
Image files usually also contain metadata. 
Metadata means 'data about data' and provides 
information about the image; this may include:
• filename 
• file format e.g. JPEG, GIF or PNG 
• dimensions 
• resolution i.e. dots per inch
• colour depth i.e. amount of bits available
• time and date the image was last changed 
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JPG or JPEG and TIFF support 24 bit 
colour images. The range of unsigned 
integers that can be represented in 
24 bits is 0 to 16,777,215, so such 
image files can have up to 16,777,216 
possible colours per pixel.

In the list of options, you will 
sometimes have the option to scan  
in 24 bit. This is the best choice for 
quality scans and you should take it 
whenever you can. 
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Some scanning programs have a facility by which you can choose 
to preview the scanned image prior to saving the image file.

Clicking preview allows you to review your selection make 
necessary changes to the settings. 

Use the preview to decide on the type of format, orientation 
and resolution before continuing. 
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If your scanning program has options for adjusting 
the levels and saturation before scanning, it is 
better to take that option. 

Levels and saturation settings change the colours, 
the darkness, and brightness in an image, which 
for instance can help with a faded picture. 

Adjusting these within a photo editing program 
later can damage the image and lose a lot of the 
detail. 
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Take your time to get the images 
orientated and aligned properly in   
the scanner. 

Do not rotate the scanned images in 
the scanning program. 

When you turn the images in the 
scanning program's preview window 
(or even rotate them afterwards in a 
photo editor), you can lose some 
image quality. 

Scan them in the correct orientation 
to begin with and you'll help preserve 
the quality of your image. 
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Once you have chosen the settings you want in the preview, 
click "Finish" or "Scan" to continue and complete the process. 
Which word is used will depend on your program, and another 
one altogether may even be used. 
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Use the program to guide you through the process. The 
program normally will show you step-by-step how to save 
pictures from a scanner to the computer or web site.

Some programs will automatically save your images to a cache 
within the program itself, but for most programs you will need 
to save the images somewhere on your computer or upload 
them directly to the internet. Look for the save button, or use 
the save prompt when it comes up. 

It is best to give the files
meaningful names and 
save them in a folder 
for subsequent retrieval. 
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If you intend to use the images on the internet, use web-friendly names. Your web files will be viewed 
by numerous users who use a wide variety of operating systems (Mac, PC, and Linux for instance) 
and devices (desktops, tablets, and smartphones are some examples). Therefore, it is essential to 
play it safe and avoid certain characters.

Do not use any of these common characters/symbols:

Also, keep these rules in mind.
• Don’t start or end a filename with a space, full stop, hyphen, or underline.
• Keep filenames to a reasonable length and be sure they are under 31 characters.
• Most operating systems are case sensitive; always use lowercase.
• Avoid using spaces and underscores; use a hyphen instead.
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• Scan up to 600 dpi JPGs, TIFFs and PDFs

• Up to A3 size

• Saves to USB stick

• Good for medium-sized, modern books, 
stamps, and postal history items

• Good for where you have a few scans

• Black lid lining, useful for contrast

• Located in the Small Library for 
Members’ to use for free.

Plustek - Walk up scanner at No. 41 Devonshire Place

Digital Philately for Beginners
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Resolution: “72 DPI”
1191 x 779 pixels
File size: 1.2 MBytes

40%

Alternative to using a Scanner
– Digital Photography

“Any advice on 
photography vs 
scanning for 
collection items?”
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Alternative to using a Scanner – Digital Photography

Quality 
Overall, the image quality is superior on the scanner. Zoom in on a 
camera photograph and the same page captured with a scanner and 
see which holds up better. Cameras do a great job at portraits and 
scenery, but not such a good job with documents, covers and stamps. 

Lighting 
A camera relies on reflecting light to the lens. You 
either get limited ambient light or harsh flash, hot 
spots on the item, glare on glossy surfaces, basically 
inconsistent and unpredictable lighting. 

Using a camera to capture images of stamps and items of postal history generally gives limited, low-quality 
results. Several things contribute to the poor results: 

Focus 
The camera shot is often out of focus from trying to 
frame the item and getting too close. 

Aspect 
The camera is rarely at the perfect top-down angle 
while the scanner positions the item perfectly flat 
and at the proper angle. 

File Size 
The scanner’s file size is less than half that of the camera photo, yet 
the scanner has better image quality. 

Cropping 
You have to crop your item as best you can with the camera and you 
may still get more table top around the item than you want. The 
scanner cropping is superior. 
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Scan, resolution: 600 DPI

Alternative to using a Scanner – Digital Photography

Photograph, resolution: 72 DPI                                       scaled to 20%

Enlargement from scan, resolution: 96 DPI                                       
scaled to 30%



Digital Philately for Beginners

Alternative to using a Scanner – Digital Photography



Demonstration Mark Copley

Hands-on practical session All participants

Digital Philately for Beginners

Scanning Philatelic Material

 Scanning stamps and/or covers 

 Crop within preview as required

 Scan at different resolutions (300 dpi or higher)

 Save scanned images to a folder for later use

 Use meaningful names for the image files
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Making Large, Detailed Images
Start with your ‘Master’ image
• Start with High Resolution scans or images

Istanbul Liannos et cie Private City Post 
1865 5 paras blue imperforate



Start with your ‘Master’ image
• Start with High Resolution scans or images
• If required, rotate the image

Digital Philately for Beginners

Making Large, Detailed Images

Free graphics software:
http://www.irfanview.com/
http://download.cnet.com/IrfanView/

http://www.irfanview.com/
http://download.cnet.com/IrfanView/


Start with your ‘Master’ image
• Start with High Resolution scans or images
• If required, rotate the image
• Crop the image

Digital Philately for Beginners

Making Large, Detailed Images
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Making Large, Detailed Images
Start with your ‘Master’ image
• Start with High Resolution scans or images
• If required, rotate the image
• Crop the image
• Amend the Property details (Metadata)

Right click the image file > Properties



Start with your ‘Master’ image
• Start with High Resolution scans or images
• If required, rotate the image
• Crop the image
• Amend the Property details (Metadata)

Right click the image file > Properties
• Save your edited image

Digital Philately for Beginners

Making Large, Detailed Images
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Making Large, Detailed Images
For Displays
• For enlarged detail on a sheet, 

crop a high resolution image 
rather than enlarge a low resolution 
image

Can use IrfanView or Microsoft Word

IrfanView: save the edited version with a 
new filename

Cropping an image in Word 

N.B. Microsoft PowerPoint has the 
same functionality as Microsoft Word 



Digital Philately for Beginners

Making Large, Detailed Images

For Websites
• Use JPG, PNG or GIF format for images 

(can use IrfanView)
Initial scan:

pen-01.tiff

600 dpi
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Making Large, Detailed Images

For the Web, 
Resize using 
pixel 
dimensions of 
the image



Initial scan:
pen-01.tiff
3000 x1000 pixels

Web friendly image:
pen-01-web.jpg
300 x 100 pixels
Line art: use GIFs

Digital Philately for Beginners

Making Large, Detailed Images
For Websites
• Use JPG, PNG or GIF format for images 

(can use IrfanView)
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Making Large, Detailed Images
N.B. Emails
• Some email programs compress files
• Better to use wetransfer.com or zip the 

files
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Changing the pixel dimensions of an image 
is called resampling. 

Resampling affects not only the size of an 
image on screen, but also its image quality 
and its printed output—either its printed 
dimensions or its image resolution. 

Resampling can degrade image quality. 
When you “downsample”, decreasing the 
number of pixels in the image, information 
is removed from the image. When you 
“upsample”, or increase the number of 
pixels in your image, new pixels are added 
based on the colour values of existing 
pixels, and the image loses some detail 
and sharpness.

To avoid the need for “upsampling”, scan 
or create the image at the resolution 
required for your printer or output device. 

If you want to preview the effects of 
changing pixel dimensions on screen or 
print proofs at different resolutions, 
resample a duplicate of your file.

Resampling Images in Photoshop Elements



10.30 am Tea, coffee and biscuits

11 am Welcome and opening remarks Frank Walton 

11.10 am Scanning philatelic material Mark Bailey

Demonstration Mark Copley

Hands-on practical session All participants

12 noon Making enlarged, detailed images Mark Copley

12.30 pm Lunch break

Optional: Lunch at the King’s Head 

1.30 pm Different colour standards Mark Bailey

1.35 pm Preparation of physical display sheets Mark Copley

Hands-on practical session All participants

3 pm Refreshment break

3.15 pm Producing digital exhibits Mark Copley

3.45 pm Preparing slideshow presentations Mark Bailey

4.15 pm Wrap-up session, with Questions & Answers All participants

4.30 pm Closing remarks Mark Bailey
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Different Colour Standards

RGB and CMYK Colour Modes
A Brief Introduction to this ‘black art’

What is the Relevance?

• The technology for printing and for screen presentation is different.
• You should not expect colours that you see on a screen to be identical 

to what is printed.

You need to consider the main purpose of the document being created.



RGB is an additive colour model. This means that 
these 3 colours are mixed together to create the 
range of colours that you can see on electronic 
devices (black is no light).

RGB Colour Mode
RGB is the colour scheme associated with electronic display 
screens such as cameras, TVs and computer monitors. RGB 
stands for three colours:

• R = Red

• G = Green

• B = Blue
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CMYK is the colour scheme that is used by printers to create the 
many colours that end up on the page. 

It is made up of four colours created from mixing the RGB colours.

• C = Cyan is a mix of green (G) and blue (B),

• M = Magenta is a mix of red (R) and blue (B) 

• Y = Yellow is a mix of red (R) and green (G).

• K = Black is added to the CMYK model as the 3 colours             
RGB cannot be mixed to create the colour black

The CMYK colour model is a subtractive model 
because it subtracts the brightness from white. 

Digital Philately for Beginners

CMYK Colour Mode



RGB and CMYK Summary
Digital Philately for Beginners

RGB Additive Colour CMYK Subtractive Colour



Document / Image Creation
Software Support
• Most software will scan in RGB and will not support CMYK at all

• This includes Microsoft Word, Microsoft Publisher, Adobe Photoshop Elements, and Irfanview

• Only high end software products such as Adobe Creative Suite (now Cloud) 
(which includes Photoshop and Indesign) handle CMYK.

• This is used for production of the London Philatelist and usually for creating RPSL books.

• Expensive: £46 per month!

Implication
• Therefore, any document that has been created using software that only 

supports RGB needs to be converted to CMYK for printing.

• This can be done as part of the printing process or specific software is used by 
printers to do it before printing.
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The Effect of Conversion between RGB and CMYK?

Assessment
• Difficult to assess the impact of the conversion without actually doing a test print

Digital Philately for Beginners



RGB and CMYK Colour Modes
Conclusion
Does colour accuracy for printing matter?

If so, then you need to use CMYK, so talk to the printer / editor about how to achieve it.

Otherwise, use RGB technology and accept a printed version might look a bit different.

Conversion Software
Online converter at: http://www.cmykconverter.com

Digital Philately for Beginners
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Isolating Cancellations from Scanned Stamps and Postal History

Tip: Work on a copy of your image, not the original.

1. Open a copy of your image in Photoshop. If the image has layers, use the menu command Layer> Flatten 
Image. From the Channels palette menu, choose Split Channels. (NOTE: This command cannot be undone. 
However, you can reverse the process with the Channels palette menu command Merge Channels.) 

A separate file is created from each colour channel in the image. The grayscale images show the distribution 
of each colour throughout the image. The individual file names include the channel’s colour after the file 
extension. Be aware that this file naming convention can prevent file type recognition by the operating 
system. You may need to re-name the files. 

2. With the Cyan file active, use the menu command Image> Mode> Duotone. In the Duotone dialog box, 
select Monotone (which uses a single ink). Click the colour swatch to the left of the ink name and define the 
monotone’s ink as CMYK 100/0/0/0. (You can also select Pantone Process Cyan from the Custom Colours.)

Using the same procedure, convert the Magenta file to a Monotone using CMYK 0/100/0/0 and the Yellow 
file to a Monotone using CMYK 0/0/100/0. The Black file can be left as Grayscale.

These images can now be used individually, producing colour separations in their own colours. (These 
colour separations cannot be used to produce printing plates.)

The technique works best with a black postmark 
on a light coloured stamp.

a. First scan the desired cancel and stamp.

b. In Image Editing software, split the image by 
creating a CMYK split. This creates four new 
(greyscale) images, each containing the colour 
information for one of the 4 ink colours ( Cyan, 
Magenta, Yellow, and Black ) that would be used 
to print the original image.

c. Use the black 'channel' containing a negative 
image of the black parts of the original scan.

d. Invert the image colours, using the 'Invert 
Colours' command to replace black with white 
and vice-versa. 

e. Retouch the image as desired for the final 
required image. 

f. Save image(s) for future use. 

This technique can also be used for 'lifting' transit 
marks, instructional marks, etc. for printing 
alongside the original item that has been 
mounted on the album page. 

It is also useful for reproducing the marks on the 
reverse side of a cover. 

It's up to you to how much 'repair' work you do 
to the final image, but remember it is unethical to 
alter (enhance) the original philatelic item in any 
way. 

More reading on the subject (RGB images and CMYK processing):
http://www.slideshare.net/bobswansons/isolating-cancellations-ver2



Preparation of Physical Display Sheets

You can use Microsoft Word – it’s easy!
(and you can use Microsoft PowerPoint as well)
Initial checklist:

• Page size

• Margin size

• Orientation

Digital Philately for Beginners



Right click
Preparation of Physical Display Sheets

Digital Philately for Beginners

Optional: Styles

• Create Styles so that text is the same 
style throughout the display

• This can be saved as a template



Optional: Master Sheet

• Styles

• Text boxes

• Headers

• Footers

Save it to use as a master sheet which can be used 
for all your display sheets

Preparation of Physical Display Sheets

Digital Philately for Beginners



Text box size

Align to page

For overlapping items, bring 
up a layer or send back a layer

Can change the 
Shape Fill to
transparent

Shape outline can be
any colour or thickness

Preparation of Physical Display Sheets

Digital Philately for Beginners

Creating your layout

• Text boxes

Insert > Text box



Creating your layout

• Inserting images

Insert > Picture

Image sizePosition in front of text

Can Crop
in MS Word

Preparation of Physical Display Sheets

Digital Philately for Beginners

Align to pageFor overlapping items, bring 
up a layer or send back a layer



Creating your layout

• Can crop an image to a shape

• Choose the shape

Preparation of Physical Display Sheets

Digital Philately for Beginners



Creating your layout

• Can flip an image

Preparation of Physical Display Sheets

Digital Philately for Beginners

… flipped shows the 
postmark produced 
by the hand stamp.

An image showing 
the hand stamp …



• Add Shapes

Insert > Shapes, then select Rectangle

Preparation of Physical Display Sheets

Digital Philately for Beginners

• Format Shapes

Click shape > Format

• Size the Rectangle correctly
• tip: allow 2 mm extra on each 

side and top and bottom to 
surround the item



• Shape Fill

Preparation of Physical Display Sheets

Digital Philately for Beginners

• Shape Outline, to change the outline as 
required (line style and colour)

Shape outline can be from
many colours, thicknesses or line styles



• Copy and paste the rectangle 
to add more of the same

Preparation of Physical Display Sheets

Digital Philately for Beginners

• Click, shift, click … to select 
the top 2, then Align



Preparation of Physical Display Sheets

Digital Philately for Beginners

• Use Alignment options to align 
the rectangles as required, and 
repeat for the other rectangles



• Add Shapes

Insert > Shapes

Preparation of Physical Display Sheets

Digital Philately for Beginners

• Format Shapes

Click shape > Format
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Non-competitive display
Competitive exhibit

Border on box shapes outlining the items

Border on box 
shapes outlining 
the items

Succinct title

Relevant 
supporting 
picture

Succinct 
caption

Short introductory paragraph (2 or 3 sentences)

Use of accenting colour text to draw 
the eye to important information

Explanatory 
paragraphs Numerous 

text boxes
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Rectangular shape outlining the item

Succinct 
captions in 
text boxes

Laying out your sheets

Bringing the techniques together

Photographic images 
flipped to show the 
postmark produced by the 
hand stamp (also with thin 
border, consistent with the 
style of the other items)



Laying out your sheets

Bringing the techniques together

Digital Philately for Beginners

Border on box 
shapes outlining 
the items

Good to align different size items on the bottom

Rectangles 
aligned to 
present the 
stamps 
symmetrically 

Not on the top (“clothes on a washing line”)
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Left edges 
aligned

Right edges 
aligned

Centred in the 
row of three
(and in the centre 
of the sheet)

Items also look good aligned items by their middles

Laying out your sheets

Bringing the techniques together
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Bottom edges of these 
rows of objects are aligned

Distributed 
horizontally 
across the page

Laying out your sheets

Aligned centred to the page
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As a guideline, don’t put too much on a single 
sheet. Up to about 16 stamps is fine, above that 
the sheet will likely look too crowded.

Symmetry

Alignment

Horizontal and vertical distribution

Succinct text in text boxes

Laying out your sheets

Bringing the techniques together
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What a superb way to display these 
Specimen strips.

Laying out your sheets

Bringing the techniques together
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Sometimes just a rectangle will not be sufficient, 
so you may need to get a little creative.

Laying out your sheets

Rotate the shape

Adjust the size of the 
corners and centre section

Use the shape “Snip Same Side Corner Rectangle”

Format the 
shape’s Line

Format the 
shape’s Fill
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Left edges 
aligned

Two rectangles overlapped to 
form a frame for the 2 covers

Laying out your sheets

To hide the overlapping, to present a 
neater outline, overlay the joins with 
a white rectangle with no outline
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Left edges 
aligned

Three rectangles overlapped to 
form a frame for the 3 covers

Laying out your sheets
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Three rectangles form a frame 
for this item from the archive

Laying out your sheets
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Sometimes it can be difficult to just use the 
regular shapes, so you may need to draw an 
outline using straight lines.

Laying out your sheets
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Sometimes even straight lines will not do,          
so consider scanning the result of freehand 
drawing of an outline, or a cut out on paper,   
and then incorporate the resulting image         
into the sheet.

Laying out your sheets

Adding detailed images

Including an enlarged image of part of the 
stamp brings out the detail, and placing it 
alongside the artwork, at the same size, is 
very effective in telling the story of the 
stamp design process.



Digital Philately for Beginners Adding detailed images

The images showing 
examples of the 
postage due 
marking, the fancy 
cancelation and rate 
marking may have 
been scanned from 
reference books.



Hands-on practical session All participants

Digital Philately for Beginners

Preparation of Physical Display Sheets

 Title of the sheet

 Brief explanatory introductory paragraph

 Images of the stamps or covers at 100%

 Boxes around the images to act as frames around the items 

 Perhaps add a detail image or reduced size scan

 Position and align the elements appropriately

 Include text boxes with captions



10.30 am Tea, coffee and biscuits

11 am Welcome and opening remarks Frank Walton 

11.10 am Scanning philatelic material Mark Bailey

Demonstration Mark Copley

Hands-on practical session All participants

12 noon Making enlarged, detailed images Mark Copley

12.30 pm Lunch break

Optional: Lunch at the King’s Head – pre-book the food

1.30 pm Different colour standards Mark Bailey

1.35 pm Preparation of physical display sheets Mark Copley

Hands-on practical session All participants

3 pm Refreshment break

3.15 pm Producing digital exhibits Mark Copley

3.45 pm Preparing slideshow presentations Mark Bailey

4.15 pm Wrap-up session, with Questions & Answers All participants

4.30 pm Closing remarks Mark Bailey

Digital Philately for Beginners



• Adding Metadata to Microsoft Word documents

• Creating PDF files from Microsoft Word documents

• Creating Flip Books

Digital Philately for Beginners

Producing Digital Exhibits



• Adding Metadata to Microsoft Word documents

Click File > Info

This is added to any resultant PDF file

Digital Philately for Beginners



Digital Philately for Beginners

Producing Digital Exhibits

• Creating PDF files from Microsoft Word documents

Save As > PDF

Optimize either for Standard (High Resolution, for printing or online viewing) or 

Minimum size (for publishing on the Web)



• Creating PDF files from Microsoft Word documents

Save As > PDF

Use OCR (Optical Character Recognition) to create searchable text

Adobe® Acrobat Pro is £12pm Will also allow you to edit the text and images

ABBYY ® PDF Transformer+ £60                               https://www.abbyy.com/en-gb/pdf-transformer/

Digital Philately for Beginners

Producing Digital Exhibits



• Creating PDF files from Microsoft Word documents

Add more Metadata in the PDF file:

File > Properties > Additional Metadata

Digital Philately for Beginners

Producing Digital Exhibits
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Producing Digital Exhibits

• Creating Flip Books

Flip books are a great way of placing your 
exhibit on the web in a fun, interactive way

Flip PDF from Flip Builder $99

http://www.flipbuilder.com/flip-pdf/

http://www.flipbuilder.com/flip-pdf/
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Producing Digital Exhibits

• Creating Flip Books

An example – one of our Standing Displays:

http://www.rpsl.org.uk/documents/standing/SD2016-07_Hugh_Osborne_South_Georgia_etc/

• Can create a whole Library and place on the web

http://www.rpsl.org.uk/documents/standing/SD2016-07_Hugh_Osborne_South_Georgia_etc/
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Preparing Slideshow Presentations

10 key points to bear in mind 
when preparing slideshows, 
e.g. with Microsoft PowerPoint
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Preparing Slideshow Presentations

1. Know your goal - make each slide count 
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Preparing Slideshow Presentations

1. Know your goal - make each slide count 
2. Plan it out - in some detail 
3. Generally, avoid templates - they can detract
4. Choose a colour scheme - 4 colours, 1 accent 

Choose 1 accent colour that stands out from the rest
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Preparing Slideshow Presentations

1. Know your goal - make each slide count 
2. Plan it out - in some detail 
3. Generally, avoid templates - they can detract
4. Choose a colour scheme - 4 colours, 1 accent 
5. Choose a font scheme - match tone 

and a font for accents
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Preparing Slideshow Presentations

1. Know your goal - make each slide count 
2. Plan it out - in some detail 
3. Generally, avoid templates - they can detract
4. Choose a colour scheme - 4 colours, 1 accent 
5. Choose a font scheme - match tone 
6. Choose a layout scheme - comprehension 
7. Use images (wisely) - they’re more memorable 
8. Keep to 15 words or less per slide
9. Play with typography - impact, interest
10. Don’t overdo it - white space 



Thank You

Digital Philately for Beginners
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